Chapter 442

Confidence Intervals for One-Way Repeated Measures Contrasts

Introduction

This module calculates the expected width of a confidence interval for a contrast (linear combination) of the means in a one-way repeated measures design using either the multivariate test or the univariate test as described by Maxwell and Delaney (2003) and Davis (2002).

A repeated measures design is one in which subjects are observed at a fixed set of time points. These time points do not have to be equally spaced, but they must be identical for all subjects. A confidence interval about a contrast of the means can be calculated using the Student’s t distribution.

Why Do We Promote the Multivariate Approach Instead of the Univariate Approach?

As we researched this procedure, we found that there were two possible methods to construct the confidence interval: multivariate and univariate. The univariate procedure was at first attractive because it gives more denominator degrees of freedom. Unfortunately, the univariate approach can only be used when all correlations among the measurements at the different time points are equal (compound symmetry). This assumption is seldom met in practice in repeated measures data. It is often met in a split plot design.

Therefore, Maxwell and Delaney (2003) recommend the multivariate approach because it makes no special assumption about the correlation pattern and it forms a specific error term that depends only on the time points used in the contrast.

For a very comprehensive discussion of when to use the each statistic, we refer you to Maxwell and Delaney (2003).
Technical Details

The confidence interval details are presented in Rencher (1998). We refer you to that reference for more details.

Technical Details for the Multivariate Approach

In one-factor case, a sample of $N$ subjects are measured at $M$ time points. We assume that all $N$ subjects have the same multivariate normal distribution with mean vector $\mu$ and variance covariance matrix $\Sigma$. Rencher (1998) shows that a 100 $(1 - \alpha)$% confidence interval for $\sum c_i \mu_i$ may be computed using

$$C'y - t_{1 - \alpha/2, N-1} \sqrt{\frac{C'SC}{N}} \leq C'\mu \leq C'y + t_{1 - \alpha/2, N-1} \sqrt{\frac{C'SC}{N}}$$

where $y$ is the $M$-dimensional vector of sample means, $C$ is $M$-dimensional vector of contrast coefficients, and $S$ is the sample variance-covariance matrix.

The distance from the contrast to either of the limits is thus

$$D = t_{1 - \alpha/2, N-1} \sqrt{\frac{C'SC}{N}}$$

This formula can be used to calculate an appropriate sample size.

Technical Details for the Univariate Approach

The univariate (or mixed-models) approach may be used to calculate a 100 $(1 - \alpha)$% confidence interval for $\sum c_i \mu_i$ if we are willing to adopt the very restrictive assumption of compound symmetry in the covariance matrix.

If we are willing to adopt this assumption, the confidence interval is calculated using

$$C'y - t_{1 - \alpha/2, (M-1)(N-1)} \sqrt{\frac{MS_{ST}C'C}{N}} \leq C'\mu \leq C'y + t_{1 - \alpha/2, (M-1)(N-1)} \sqrt{MS_{ST}C'C}{N}$$

where $MS_{ST}$ is time period-by-subject interaction mean square.

The distance from the contrast to either of the limits is thus

$$D = t_{1 - \alpha/2, N-1} \sqrt{\frac{MS_{ST}C'C}{N}}$$

This formula can be used to calculate an appropriate sample size.

PASS requires the input of $\sigma_Y$ and $\rho$. These can be estimated from a repeated measures ANOVA table which provides values for $MS_S$ (mean square of subjects) and $MS_{ST}$ (mean square of subject-time interaction). The parameters can then be calculated as follows

$$\hat{\rho} = \frac{F - 1}{F - 1 + M}, \quad F = \frac{MS_{ST}}{MS_S}, \quad \hat{\sigma}^2_\rho = \frac{MS_{ST}}{1 - \hat{\rho}}$$

It is useful to note the following expectations

$$E(MS_{ST}) = \sigma^2_Y (1 - \rho)$$
$$E(MS_S) = \sigma^2_Y (1 + (M - 1)\rho)$$
Covariance Patterns

In a repeated measures design with \( N \) subjects, each measured \( M \) times, observations within a single subject may be correlated, and a pattern for their covariance must be specified. In this case, the overall covariance matrix will have the block-diagonal form:

\[
V = \begin{pmatrix}
V_1 & 0 & 0 & \cdots & 0 \\
0 & V_2 & 0 & \cdots & 0 \\
0 & 0 & V_3 & \cdots & 0 \\
\vdots & \vdots & \vdots & \ddots & \vdots \\
0 & 0 & 0 & \cdots & V_N \\
\end{pmatrix},
\]

where \( V_i \) is the \( M \times M \) covariance sub matrices corresponding to the \( i \)th subject. The 0's represent \( M \times M \) matrices of zeros giving zero covariances for observations on different subjects. This routine allows the specification of four different covariance matrix types: All \( \rho \)'s Equal, AR(1), Banded(1), and Banded(2).

**All \( \rho \)'s Equal (Compound Symmetry)**

A compound symmetry covariance model assumes that all covariances are equal, and all variances on the diagonal are equal. That is

\[
\Sigma = \sigma^2 \begin{pmatrix}
1 & \rho & \rho & \cdots & \rho \\
\rho & 1 & \rho & \cdots & \rho \\
\rho & \rho & 1 & \cdots & \rho \\
\vdots & \vdots & \vdots & \ddots & \vdots \\
\rho & \rho & \rho & \cdots & 1 \\
\end{pmatrix}_{M \times M}
\]

where \( \sigma^2 \) is the subject variance and \( \rho \) is the correlation between observations on the same subject.

**AR(1)**

An AR(1) (autoregressive order 1) covariance model assumes that all variances on the diagonal are equal and that covariances \( t \) time periods apart are equal to \( \rho \sigma^2 \). **This choice is recommended**. That is

\[
\Sigma = \sigma^2 \begin{pmatrix}
1 & \rho & \rho^2 & \rho^3 & \cdots & \rho^{M-1} \\
\rho & 1 & \rho & \rho^2 & \cdots & \rho^{M-2} \\
\rho^2 & \rho & 1 & \rho & \cdots & \rho^{M-3} \\
\rho^3 & \rho^2 & \rho & 1 & \cdots & \rho^{M-4} \\
\vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\
\rho^{M-1} & \rho^{M-2} & \rho^{M-3} & \rho^{M-4} & \cdots & 1 \\
\end{pmatrix}_{M \times M}
\]

where \( \sigma^2 \) is the residual variance and \( \rho \) is the correlation between observations on the same subject.
Banded(1)
A Banded(1) (banded order 1) covariance model assumes that all variances on the diagonal are equal, covariances for observations one time period apart are equal to $\rho \sigma^2$, and covariances for measurements greater than one time period apart are equal to zero. That is

$$
\Sigma = \sigma^2 \begin{pmatrix}
1 & \rho & 0 & 0 & \cdots & 0 \\
\rho & 1 & \rho & 0 & \cdots & 0 \\
0 & \rho & 1 & \rho & \cdots & 0 \\
0 & 0 & \rho & 1 & \cdots & 0 \\
\vdots & \vdots & \vdots & \ddots & \ddots & \vdots \\
0 & 0 & 0 & 0 & \cdots & 1
\end{pmatrix}_{M \times M}
$$

where $\sigma^2$ is the residual variance and $\rho$ is the correlation between observations on the same subject.

Banded(2)
A Banded(2) (banded order 2) covariance model assumes that all variances on the diagonal are equal, covariances for observations one or two time periods apart are equal to $\rho \sigma^2$, and covariances for measurements greater than two time period apart are equal to zero. That is

$$
\Sigma = \sigma^2 \begin{pmatrix}
1 & \rho & \rho & 0 & \cdots & 0 \\
\rho & 1 & \rho & \rho & \cdots & 0 \\
\rho & \rho & 1 & \rho & \cdots & 0 \\
0 & \rho & \rho & 1 & \cdots & 0 \\
\vdots & \vdots & \vdots & \ddots & \ddots & \vdots \\
0 & 0 & 0 & 0 & \cdots & 1
\end{pmatrix}_{M \times M}
$$

where $\sigma^2$ is the residual variance and $\rho$ is the correlation between observations on the same subject.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
This option specifies the parameter to be solved for. When you choose to solve for Sample Size, the program searches for the lowest sample size that meets the alpha and beta criterion you have specified for each of the terms. The "solve for" parameter is displayed on the vertical axis of the plot.
**Statistic and Interval Types**

**Statistic Type**
Specify the statistic that will be used.

**Multivariate (Recommended)**
The results assume that a multivariate Hotelling's $T^2$ will be used to analyze the data. The confidence interval will be based on a Student's $t$ distribution with $N-1$ degrees of freedom.

Requires no special assumptions about the structure of variance-covariance matrix. Often, an AR(1) correlation model is used.

The variance estimate of the confidence interval is specific to the contrast.

Maxwell and Delaney (2003) list this as their test of choice.

**Univariate**
Use a univariate, repeated measure ANOVA to analyze the data. The confidence interval is based on a Student's $t$ distribution with $(N-1)(M-1)$ degrees of freedom and various mean squares from the ANOVA table. The variance is the ANOVA MSE times the sum of the squared contrast coefficients.

This procedure requires the restrictive assumption that all off-diagonal elements of the variance-covariance matrix are equal. This is difficult to justify in repeated measures designs where the correlations among observations on the same subject tend to diminish across time.

**Interval Type**
Specify whether the confidence interval is one-sided or two-sided.

**Confidence**

**Confidence Level**
This is the proportion of confidence intervals (constructed with this same confidence level, sample size, etc.) that would contain the population mean. The value must be between 0 and 1. However, it is usually set to 0.95, 0.99, or 0.90 depending on the requirements of the study.

You can enter a single value such as 0.7 or a series of values such as 0.7 0.8 0.9 or 0.7 to 0.95 by 0.05.

**Sample Size**

**N (Subjects)**
Enter a value for the sample size (N), the number of individuals in the study. Each subject is measured M times. You may enter a single value or a range of values. A separate calculation will be made for each value of N you enter.

**Examples**
- 10 to 100 by 10
- 10 30 80 90
- 10, 30, 80, 90
Measurements, Contrast, and Precision

M (Measurements)
Specify the number of time points at which measurements are made.

Notes
Exactly one value must be entered. The value must be an integer greater than 1. A reasonable range is from 2 to 20. This value must match the number of Contrast Coefficients entered below when 'Custom List' is selected.

Contrast Coefficients
These options specify the coefficients (Ci’s) of the contrast that you are using. Each coefficient is multiplied by the corresponding mean in the mean-list above and then summed. The contrast value is \( \Sigma Ci \mu \).

You can either specify a type of contrast and PASS will generate the coefficients for you, or you can select Custom List and enter the coefficient values directly.

Contrast Coefficients = List
Enter a set of contrast coefficients (Ci’s) separated by commas or blanks. Each coefficient is multiplied by the corresponding mean in the mean-list above and then summed. By definition, these coefficients must sum to zero. That is, \( \Sigma Ci = 0 \). It is recommended that \( \Sigma |Ci| = 2 \).

If the number of items in the list is less than M, 0’s are added. If the number of items in the list is greater than M, extra items are ignored.

Examples
-1 0 0 1
-1 0.25 0.25 0.25 0.25
-0.5 -0.5 0.5 0.5

Contrast Coefficients = Linear Trend
A set of coefficients is generated appropriate for testing the alternative hypothesis that there is a linear (straight-line) trend across the means. These coefficients assume that the means are equally spaced across time.

Contrast Coefficients = Quadratic
A set of coefficients is generated appropriate for testing the alternative hypothesis that the means follow a quadratic model. These coefficients assume that the means are equally spaced across time.

Contrast Coefficients = Cubic
A set of coefficients is generated appropriate for testing the alternative hypothesis that the means follow a cubic model. These coefficients assume that the means are equally spaced across time.

Contrast Coefficients = First vs Rest
A set of coefficients is generated appropriate for testing the alternative hypothesis that the first mean is different from the average of the remaining means. For example, if there were four groups, the generated coefficients would be -1, 0.33, 0.33, 0.34.
D (Distance from Contrast to Limit)
Enter one or more values for the (positive) distance from the contrast value to either of the limits. This distance is often referred to as the 'Precision' or 'Half-Width' of the interval. These distances represent how narrow you want the confidence interval to be.

Scale
Note that the scale of this amount depends on the scale of the contrast coefficients. For example, the contrast '2 0 2' will be twice as large as the contrast formed using '-1 0 1.'

Range
The value(s) must be greater than zero.

Examples
5 20 60 64
2 5 7 10 22
-3, 6, 9

Standard Deviation and Correlation

Pattern of σi's Across Time
Specify whether the σi's vary across the measurement points or are the same.

Equal: σ = σ1 = σ2 = ... = σM
The σi's are constant across time. This assumption is required by the univariate F-test.

Unequal: σ1 ≠ σ2 ≠ ... ≠ σM
The σi's can vary across time. Most researchers would agree that this is a more reasonable assumption in most cases. Because of this, the multivariate tests are easier to justify.

σ (Standard Deviation) – Equal Pattern
This is the between subject standard deviation of the response variable (Y) at a particular time point. It is assumed to be the same for all time points. As a standard deviation, the number(s) must be greater than zero.

This represents the variability from subject to subject that occurs when the subjects are treated identically.

You can enter a list of values separated by blanks or commas, in which case, a separate analysis will be calculated for each value.

σ Button
You can press the σ button and select ‘Covariance Matrix’ to obtain help on estimating the standard deviation from an ANOVA table.

Examples
1,4,7,10
1 4 7 10
1 to 10 by 3

σi's (σ1, σ2, ..., σM) – Unequal Pattern
Specify how you want to enter the M σi's. Your choices are List, Range, or Sequence.

σi's (σ1, σ2, ..., σM) = List (Unequal Pattern)
Enter a list of σi's in the box that appears to the right.
σ_i's (σ1, σ2, …, σM) = Range (Unequal Pattern)
Enter a range of σ_i's by specifying the first and the last. The other σ_i’s will be generated between these values using a straight-line trend.

σ_i's (σ1, σ2, …, σM) = Sequence (Unequal Pattern)
Enter a range of σ_i’s by specifying the first and the step-size (increment) to be added for each succeeding σ_i.

h (σ_i Multiplier)
Enter a list of h values. A separate analysis is made for each value of h. For each analysis, the σ_i’s entered above are all multiplied by h. Thus σ1, σ2, …, σM become hσ1, hσ2, ..., hσM. Hence, using this parameter, you can perform a sensitivity analysis about the value(s) of the standard deviation.

Note that the resulting values must all be positive, so all h’s must be greater than 0.

If you want to ignore this option, enter a 1.

Pattern of ρ’s Across Time
Select the correlation structure for the analysis. The options are

- All ρ’s Equal
  All variances on the diagonal of the within-subject variance-covariance matrix are equal to σ^2, and all covariances are equal to ρσ^2.

\[
\Sigma = \sigma^2 \begin{pmatrix}
1 & \rho & \rho & \rho & \cdots & \rho \\
\rho & 1 & \rho & \rho & \cdots & \rho \\
\rho & \rho & 1 & \rho & \cdots & \rho \\
\vdots & \vdots & \vdots & \ddots & \cdots & \vdots \\
\rho & \rho & \rho & \rho & \cdots & 1
\end{pmatrix}_{M \times M}
\]

- AR(1)
  All variances on the diagonal of the within-subject variance-covariance matrix are equal to σ^2, and the covariance between observations t time periods apart is ρ^tσ^2.

\[
\Sigma = \sigma^2 \begin{pmatrix}
1 & \rho & \rho^2 & \rho^3 & \cdots & \rho^{M-1} \\
\rho & 1 & \rho & \rho^2 & \cdots & \rho^{M-2} \\
\rho^2 & \rho & 1 & \rho & \cdots & \rho^{M-3} \\
\rho^3 & \rho^2 & \rho & 1 & \cdots & \rho^{M-4} \\
\vdots & \vdots & \vdots & \ddots & \cdots & \vdots \\
\rho^{M-1} & \rho^{M-2} & \rho^{M-3} & \rho^{M-4} & \cdots & 1
\end{pmatrix}_{M \times M}
\]
• **Banded(1)**
  All variances on the diagonal of the within-subject variance-covariance matrix are equal to \( \sigma^2 \), and the covariance between observations one time period apart is \( \rho \sigma^2 \). Covariances between observations more than one time period apart are equal to zero.

\[
\Sigma = \sigma^2 \begin{pmatrix}
1 & \rho & 0 & 0 & \cdots & 0 \\
\rho & 1 & \rho & 0 & \cdots & 0 \\
0 & \rho & 1 & \rho & \cdots & 0 \\
0 & 0 & \rho & 1 & \cdots & 0 \\
\vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\
0 & 0 & 0 & 0 & \cdots & 1
\end{pmatrix}_{M \times M}
\]

• **Banded(2)**
  All variances on the diagonal of the within-subject variance-covariance matrix are equal to \( \sigma^2 \), and the covariance between observations one or two time periods apart are \( \rho \sigma^2 \). Covariances between observations more than two time periods apart are equal to zero.

\[
\Sigma = \sigma^2 \begin{pmatrix}
1 & \rho & \rho & 0 & \cdots & 0 \\
\rho & 1 & \rho & \rho & \cdots & 0 \\
\rho & \rho & 1 & \rho & \cdots & 0 \\
0 & \rho & \rho & 1 & \cdots & 0 \\
\vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\
0 & 0 & 0 & 0 & \cdots & 1
\end{pmatrix}_{M \times M}
\]

\( \rho \) **(Correlation)**
Specify the correlation to be used in calculating the off-diagonal elements of the covariance matrix. For pattern matrices, this value represents the correlation between measurements made on the same subject at the first and second time point.

Negative values are not permitted, so it must be between 0 and 1. When no previous information is available, some authors recommend 0.2 for a low correlation or 0.6 for a medium correlation.

You can enter a single value or a list of values.

**Examples**
- 0.1 0.2 0.3
- 0.1 to 0.7 by 0.1
- 0 0.1 0.2 0.5
Example 1 – Determining Sample Size

Researchers are planning a study of the impact of a new drug on heart rate. They want to evaluate the difference in heart rate between subjects that have taken the specific drug 30 minutes before exercise and the same subjects, two days later, who exercise without the drug.

Their experimental protocol calls for a baseline heart rate measurement, followed by exercise, followed by three additional measurements 5 minutes apart. They expect a quadratic pattern in the means and want to be able to detect a 10% difference in heart rate between the two treatments.

Similar studies have found a standard deviation of the difference between scores at each time point to be between 7 and 9, and a correlation between adjacent differences on the same individual to be 0.6. The researchers assume that a first-order autocorrelation pattern adequately models the data. Since the covariances will not be equal, they decide to use the multivariate test statistic.

They decide to find the sample size needed for a half-width of 3, 4, or 5.

The two-sided confidence interval will have a confidence level of 0.95. What sample size is necessary over a range of possible means and standard deviations?

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Confidence Intervals for One-Way Repeated Measures Contrasts procedure window by expanding Means, then Repeated Measures, and then clicking on Confidence Intervals for One-Way Repeated Measures Contrasts. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Statistic Type</td>
<td>Multivariate</td>
</tr>
<tr>
<td>Interval Type</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Confidence Level (1 – Alpha)</td>
<td>0.95</td>
</tr>
<tr>
<td>M (Measurements)</td>
<td>4</td>
</tr>
<tr>
<td>Contrast Coefficients</td>
<td>Quadratic</td>
</tr>
<tr>
<td>D (Distance from Contrast to Limit)</td>
<td>3 4 5</td>
</tr>
<tr>
<td>Pattern of σ’s Across Time</td>
<td>Equal</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>7 9</td>
</tr>
<tr>
<td>Pattern of ρ’s Across Time</td>
<td>AR(1)</td>
</tr>
<tr>
<td>ρ (Correlation)</td>
<td>0.6</td>
</tr>
</tbody>
</table>
## Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

**Numeric Results for a One-Way Repeated Measures Contrast Confidence Interval**

- **Type of C.I.:** Two-Sided Multivariate
- **Contrast:** Quadratic \( \{1 -1 -1 1\} \)
- **\( \sigma \)'s:** All Equal
- **\( \rho \)'s:** AR(1)

<table>
<thead>
<tr>
<th>Distance</th>
<th>Subjects</th>
<th>Time Points</th>
<th>Std Dev</th>
<th>Corr</th>
<th>Confidence Level</th>
<th>Contrast Std Dev</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.9969</td>
<td>40</td>
<td>4</td>
<td>7.000</td>
<td>0.600</td>
<td>0.950</td>
<td>9.371</td>
</tr>
<tr>
<td>2.9853</td>
<td>65</td>
<td>4</td>
<td>9.000</td>
<td>0.600</td>
<td>0.950</td>
<td>12.048</td>
</tr>
<tr>
<td>3.9569</td>
<td>24</td>
<td>4</td>
<td>7.000</td>
<td>0.600</td>
<td>0.950</td>
<td>9.371</td>
</tr>
<tr>
<td>3.9600</td>
<td>38</td>
<td>4</td>
<td>9.000</td>
<td>0.600</td>
<td>0.950</td>
<td>12.048</td>
</tr>
<tr>
<td>4.9932</td>
<td>16</td>
<td>4</td>
<td>7.000</td>
<td>0.600</td>
<td>0.950</td>
<td>9.371</td>
</tr>
<tr>
<td>4.9731</td>
<td>25</td>
<td>4</td>
<td>9.000</td>
<td>0.600</td>
<td>0.950</td>
<td>12.048</td>
</tr>
</tbody>
</table>

**References**


**Report Definitions**

- **D** is the distance from the contrast value to the limit(s).
- **N** is the number of subjects. Each subject is measured at two or more time points.
- **M** is the number of measurements obtained on each subject.
- **\( \sigma \)** is the standard deviation across subjects at a given time point. It is assumed to be identical for all time points.
- **\( \rho \)** is the (auto)correlation between observations made on a subject at the first and second time points.
- **CL** is confidence level of the confidence interval.
- **\( \sqrt{C'VC} \)** is standard deviation of the contrast value.

**Summary Statements**

A one-way repeated measures design with a sample of 40 subjects, measured at 4 time points, has an expected distance of 2.9969 from the contrast value to a limit using a confidence level of 0.950 computed from a t distribution using a two-sided, multivariate statistic. The standard deviation across subjects at the same time point is assumed to be 7.000. The pattern of the covariance matrix is AR(1) with a correlation of 0.600 between the first and second time point measurements.

This report gives the half-width (distance) for each value of the other parameters. The definitions are shown in the report.
The chart shows the relationship between N, D, and σ when the other parameters in the design are held constant.

The chart shows a 3D view of the relationship between N, D, and σ when the other parameters in the design are held constant.
Example 2 – Validation using Hand Calculations

We will compute the following example by hand and then compare that with the results that PASS obtains. Here are the settings:

Statistics Type: Multivariable
Interval Type: Two-Sided
Confidence Level: 0.95
N: 20
M: 3
Coefficients: -1, 0.5, 0.5
σ: 2
ρ: 0.2
Covariance Type: All ρ’s Equal

Using these values, we find the following

\[ C'\mu = 3 \]
\[ C'VC = 4.8 \]
\[ \Delta = 0.3 \]
\[ t_{0.975,19} = 2.09302 \]

The above results in

\[ D = 1.0254 \]

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the **Confidence Intervals for One-Way Repeated Measures Contrasts** procedure window by expanding **Means**, then **Repeated Measures**, and then clicking on **Confidence Intervals for One-Way Repeated Measures Contrasts**. You may then make the appropriate entries as listed below, or open Example 1 by going to the **File** menu and choosing **Open Example Template**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve For</td>
<td>Distance from Contrast to Limit</td>
</tr>
<tr>
<td>Statistic Type</td>
<td>Multivariate</td>
</tr>
<tr>
<td>Interval Type</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Confidence Level (1 – Alpha)</td>
<td>0.95</td>
</tr>
<tr>
<td>N (Subjects)</td>
<td>20</td>
</tr>
<tr>
<td>M (Measurements)</td>
<td>3</td>
</tr>
<tr>
<td>Contrast Coefficients</td>
<td>List</td>
</tr>
<tr>
<td>List of Coefficients</td>
<td>-1 0.5 0.5</td>
</tr>
<tr>
<td>Pattern of σ’s Across Time</td>
<td>Equal</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>2</td>
</tr>
<tr>
<td>Pattern of ρ’s Across Time</td>
<td>All ρ’s Equal</td>
</tr>
<tr>
<td>ρ (Correlation)</td>
<td>0.2</td>
</tr>
</tbody>
</table>
Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Distance</th>
<th>Subjects</th>
<th>Time Points</th>
<th>Std Dev</th>
<th>Corr ρ</th>
<th>Confidence Level</th>
<th>Contrast Std Dev</th>
<th>√(C'VC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0254</td>
<td>20</td>
<td>3</td>
<td>2.000</td>
<td>0.200</td>
<td>0.950</td>
<td>2.191</td>
<td></td>
</tr>
</tbody>
</table>

The distance of 1.0254 matches our hand calculations.